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Planning for the Installation
Before installing Cisco Process Orchestrator, you should verify that your system meets the minimum hardware and 
software requirements. For the requirements necessary to operate Cisco Process Orchestrator, see the Cisco Process 
Orchestrator Compatibility Matrix. 

Cisco Process Orchestrator Performance Best Practice Guidelines
Cisco Process Orchestrator’s multi-threaded architecture allows it to fully utilize all processors on the Cisco Process 
Orchestrator server system. Cisco Process Orchestrator generally scales linearly with the number of processor cores and 
the clock speed at which processors execute. Adding more CPU cores is the single most effective factor in increasing 
Cisco Process Orchestrator performance. To maximize performance capacity, include the maximum number of 
processor cores available in the hardware supporting the Cisco Process Orchestrator server.

The Cisco Process Orchestrator server intelligently caches data such as actively running processes to optimize 
performance. Sufficient memory is required to minimize paging. Allow memory to handle burst situations, but plan the 
number of processor cores in the system to be sufficient for steady state (average) load. 

Database optimization is very important. While Cisco Process Orchestrator ships with a schema, which is performance 
optimized, including the relevant indices, customers need to install and operate this database. Customers should refer 
to documentation associated with their chosen database platform for best practice. 

In high performance scenarios, the following best practices can dramatically affect performance:

 A separate host server for the database versus other Cisco Process Orchestrator architectural elements

 A separate high speed disk for the database, operating system and program files, and swap files

 Sufficient memory to avoid paging

A high speed network connection typically means the database is “close by” the Cisco Process Orchestrator server, or 
possibly in the same data center.

Proper database server hardware and routine database maintenance can have substantial effects on performance. 
Planning for high availability can have impacts on system design, requirements, environments, and installation topologies. 

Cisco Process Orchestrator Ports and Services
This section provides the active ports and services used by Cisco Process Orchestrator as well as the recommended 
Exchange ports for use when executing targets.
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Verifying that the Server Meets the Installation Prerequisites
Default Cisco Process Orchestrator Ports
The following table provides the list of all active TCP/IP ports used or consumed by Cisco Process Orchestrator. In 
addition, to make sure that your Active Directory environment is configured properly with the correct ports, see the 
Microsoft site, Active Directory and Active Directory Domain Services Port Requirements. 

Default Cisco Process Orchestrator Services
The Cisco Process Orchestrator service will not start if the System cryptography: Use FIPS compliant algorithms for 
encryption, hashing, and signing local security policy is enabled. For additional information on the policy, see the 
Microsoft site, http://support.microsoft.com/kb/811833.

To disable this option, choose Start > Administration Tools > Local Security Policy.

The following table provides the list of the current platform services that should be provided or enabled to use Cisco 
Process Orchestrator. 

Verifying that the Server Meets the Installation Prerequisites
Before You Begin
Verify that your machine meets the minimum requirements for installing Cisco Process Orchestrator by: 

Table 1 Cisco Process Orchestrator Ports

Protocol Port Description

HTTP TCP:56803 Default port for Cisco Process Orchestrator Server to connect 
to AdapterHost processes

HTTP TCP:56804 Default port for Java Adapter Host services processes to 
connect to AdapterHost process

HTTP TCP:61525 Client communications port for Cisco Process Orchestrator. 
This is the port that the Cisco Process Orchestrator Server and 
the Cisco Process Orchestrator client communicate over.

HTTP UDP:161 Default SNMP adapter port for Set/Get Request on remote 
SNMP server 

HTTP UDP:162 Default SNMP adapter port for Publish Trap on remote SNMP 
server 

HTTP TCP:1433 SQL Server 

HTTP TCP:2081 Default Web Console port. If the customer uses SSL with basic 
authentication, the user will have to bind a HTTPS protocol 
port to the Web Console site prior to implementing SSL.

HTTP TCP:443 Web Console

HTTPS TCP:61526 Northbound Webservice Default ports (disabled by default)

HTTP TCP:61527

Table 2 Cisco Process Orchestrator Services

Executable Files Service

svchost.exe -k iissvcs World Wide Web Publishing Service 

sqlservr.exe SQL Server

Java.exe N/A (not a service)

ReportingServicesService.exe SQL Reporting Services (Optional)
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Configuring Access Requirements
 Reviewing the Cisco Process Orchestrator 3.2.2 Compatibility Matrix.

 Manually checking your system setup or using the Prerequisite Checker on the Cisco Process Orchestrator 
Installation dialog box.

The prerequisite checker will perform the correct checks based on the platform it is running on. If the prerequisites 
checker runs on a 64-bit platform, it will detect the existence of the 64-bit prerequisite applications (such as 64-bit 
Remedy client). If the checker runs on a 32-bit platform, it will detect the 32-bit prerequisite applications.

1. Double-click the Setup.exe file.

2. On the Setup tab, click Check Prerequisites.

3. From the drop-down list, select one of the options to verify that the computer meets the requirements for the 
selected installation.

4. To view details about the displayed results, highlight the appropriate item in the Results pane.

5. After verifying the status of the system requirements, click Close.

Note: For additional information about installing Cisco Process Orchestrator, see Installing Cisco Process 
Orchestrator, page 7.

Configuring Access Requirements
Prior to installing Cisco Process Orchestrator, the following user access and configuration requirements must be met:

 Verifying User Rights, page 3

 Microsoft SQL Server Database Access Rights, page 4

 Oracle Database Access Rights, page 5

 Disabling Windows User Access Control, page 5

 Reporting Database Authentication, page 6

Verifying User Rights

Cisco Process Orchestrator Server
To install the product, the user must be a member of the Local Administrators group on the computer where Cisco 
Process Orchestrator is to be installed. 

Microsoft® SQL Server Account
The reporting database user account is used by the SQL Server Reporting Services server to connect to the Cisco 
Process OrchestratorReporting database. The account needs at least the Operator permission on the Cisco Process 
OrchestratorReporting database. The Reporting DB user needs db_datareader, db_datawriter, and execute permissions 
using the dbo default schema. 

Note: Cisco Process Orchestrator SQL Server Process database user requires db_ddladmin privilege. If Cisco Process 
Orchestrator 2.x SQL Server process database user does not have db_ddladmin privilege, the privilege should be added 
before upgrading to Cisco Process Orchestrator 3.0.
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Configuring Access Requirements
Microsoft SQL Server Database Access Rights
Admin rights to the database will grant everything needed. For POCs, lab environments, development environments, etc., 
most users just grant admin rights for the login account to the database. For production environments, DBAS may require 
more fine-grained privileges.

Microsoft Windows Server 
For the Reporting Services server that runs on Windows Server, users who import reports should be a direct member of 
the Local Administrators group on the Reporting Services server machine.

The import report process will not work if a user is a member of a global group and the global group is a member of the 
Local Administrators group. 

Microsoft SQL Server Windows Authentication
If SQL Server Windows authentication is being used, the following access rights must be set on the machine where Cisco 
Process Orchestrator is installed. To change the connection settings through the database user configuration utility on 
Cisco Process Orchestrator server, the logged in user needs to have db_datareader, db_datawriter, db_ddladmin (roles 
with dbo default schema) permission to the Cisco Process Orchestrator installation folder. 

 Windows Server 2012—The user account that connects to the database must be assigned Logon as Service rights. 

Microsoft SQL Server SQL Authentication
If SQL authentication is being used, the user account that connects to the database must have sysadmin (sa) rights on 
the machine where Cisco Process Orchestrator is installed. However, if the company requires a higher level of security 
restrictions than allowing the standard sysadmin access, then use the following scripts to create the logon script for 
access.

Process Database Logon Script
Use the following logon SQL script to create the necessary credentials for accessing the Cisco Process Orchestrator 
processes database. 

IF  EXISTS (SELECT * FROM sys.server_principals WHERE name = N'orchestratorprocess')
DROP LOGIN [orchestratorprocess]
GO
CREATE LOGIN [orchestratorprocess] WITH PASSWORD=N'cpo', DEFAULT_DATABASE=[OrchestratorProcess], 
CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
--For Windows authentication
--CREATE LOGIN [domain\userID] FROM WINDOWS WITH DEFAULT_DATABASE=[OrchestratorProcess]
GO
USE [OrchestratorProcess]
GO
IF  EXISTS (SELECT * FROM sys.database_principals WHERE name = N' orchestratorprocess ')
DROP USER [orchestratorprocess]
GO
CREATE USER [orchestratorprocess] FOR LOGIN [orchestratorprocess] WITH DEFAULT_SCHEMA=[dbo]
GO
EXEC sp_addrolemember N'db_datareader', N' orchestratorprocess '
GO
EXEC sp_addrolemember N'db_datawriter', N' orchestratorprocess '
GO

Reporting Database Authentication Script
Use the following logon script to create a SQL user account for the OrchestratorReporting reporting database. The 
assumption is that the OrchestratorReporting database will be created by a sysadmin account first, after which the script 
can be used to create a OrchestratorReporting database account with limited permission, and change reporting database 
to use the OrchestratorReporting user account.
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IF EXISTS (SELECT * FROM sys.server_principals WHERE name = N'OrchestratorReporting')
DROP LOGIN [OrchestratorReporting]
GO

CREATE LOGIN [OrchestratorReporting] WITH PASSWORD=N'cpo', DEFAULT_DATABASE=[OrchestratorReporting],
CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
--For Windows authentication
--CREATE LOGIN [domain\userID] FROM WINDOWS WITH DEFAULT_DATABASE=[OrchestratorReporting]
GO

USE [OrchestratorReporting]
GO

IF EXISTS (SELECT * FROM sys.database_principals WHERE name = N'OrchestratorReporting')
DROP USER [OrchestratorReporting]
GO

CREATE USER [OrchestratorReporting] FOR LOGIN [OrchestratorReporting] WITH DEFAULT_SCHEMA=[dbo]
GO

EXEC sp_addrolemember N'db_datareader', N'OrchestratorReporting'
GO

EXEC sp_addrolemember N'db_datawriter', N'OrchestratorReporting'
GO

GRANT EXECUTE TO OrchestratorReporting
GO

Oracle Database Access Rights
Following is a list of privileges for the Process DB user on Oracle:

 ALTER TABLESPACE

 CREATE SEQUENCE

 CREATE TABLE

 CREATE VIEW

 CREATE PROCEDURE

 CREATE SESSION

 CREATE TRIGGER

 UNLIMITED TABLESPACE 

Disabling Windows User Access Control
Disabling User Account Control (UAC) on a Windows Server can be an acceptable practice only when both of the 
following are true:

 Only Administrators are allowed to log on to the Windows Server interactively at the console or through Remote 
Desktop services.

 Administrators log on to the Windows Server only to perform legitimate system administrative functions on the 
Server.
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Configuring Access Requirements
For additional information on the impact for disabling the UAC on a Windows 2008 server, see Disabling User Account 
Control (UAC) on Windows Server.

1. Choose Start > Control Panel > Administrative Tools > Local Security Policy.

2. Expand the Security Settings > Local Policy > Security Options folders.

3. Scroll to the User Account Control: Run all administrators in Admin Approval Mode security option, right-click and 
choose Properties.

4. Click the Local Security Setting tab, select the Disabled radio button and click OK.

Note: To view explanations for security setting options, click the Explain tab. Each time the setting is changed, the 
computer must be restarted.

5. Click Restart Now to apply the change right away, or click Restart Later to restart the machine at a later time.

Reporting Database Authentication
The following is a list of privileges required by the Cisco Process OrchestratorReport user account. To create the Cisco 
Process OrchestratorReporting database manually, use the Cisco Process OrchestratorReportingCreateUser.sql script.

 CREATE SEQUENCE

 CREATE SYNONYM

 CREATE TABLE

 CREATE VIEW

 CREATE MATERIALIZED VIEW

 CREATE PROCEDURE

 CREATE CLUSTER

 CREATE JOB

 CREATE TRIGGER

 CREATE ROLE

 QUERY REWRITE

 CREATE SESSION

 MANAGE SCHEDULER

 CREATE EVALUATION CONTEXT

 CREATE RULE

 CREATE RULE SET 
6



Installing Cisco Process Orchestrator 
You can install three different components of Cisco Process Orchestrator:

 Client—Installs only the components necessary to launch the Cisco Process Orchestrator Console and use it to 
connect to an automation server located on another computer. 

 Server—Installs the automation server and all client components

 Web Console—Installs only the components necessary to provide access to the product’s Web Console

Note: Review the system requirements and prerequisites before beginning the installation process (see Planning for the 
Installation, page 1). 

Installing Using Silent Install
You can automate the installation of Cisco Process Orchestrator by running the server batch file after you enter the 
required details in the server response file (Cisco Process Orchestrator silent install configuration file).

Use the following steps to verify or enter the appropriate details in the server response file.

Note: Don’t modify the values to the left of the equal sign.

1. In the Destination Folder section, verify the default file path or enter the appropriate file path for the install directory. 
For example:

INSTALLDIR=C:\Program Files\Cisco\Process Orchestrator\

Note: Don’t enter quotes for long file path names.

2. In the Setup Type section, verify or enter the application to be installed, separated by commas. To install:

a. Client enter ConsoleFeature

b. Server enter ServerFeature

c. Web Console enter WebConsoleFeature

For example:

ADDLOCAL=ConsoleFeature,ServerFeature,WebConsoleFeature

Note: The values to be entered are case sensitive and you must install Client along with the Server.

3. In the Server Install Options section:

a. Under Server Number, specify the Server Install Option:

— For new installation, enter: 1

— To add server to HA environment, enter: 2

For example:
7

Cisco Systems, Inc. www.cisco.com



Installing Cisco Process Orchestrator

Installing Using Silent Install
SERVER_NUMBER=1

Note: You must use this section when ServerFeature is installed.

b. If this is a new installation, enter a unique name for the Cisco Process Orchestrator server environment or the 
default name is Production. For example:

HA_ENVIRONMENT_NAME=PRODUCTION

4. In the Database Information section:

a. Choose the Database Type:

— For Microsoft SQL Server, enter: 1

— For Oracle Database Server, enter: 2

For example:

DATABASETYPE=1

b. If this is an Oracle RAC Install, enter: 1, otherwise leave blank.

For example:

RAC_CHECKBOX=

Note: You must use this section when ServerFeature is installed and only if this is a new installation 
(SERVER_NUMBER is set to 1).

Updating MSSQL Details
Note: You must use this section when ServerFeature is installed and only if this is a new installation (SERVER_NUMBER 
is set to 1).

Note: You must use this section when Database Type is Microsoft SQL Server (DATABASETYPE is set to 1).

1. Under the Processes Database section:

a. Enter the Server Name. For example:

IS_SQLSERVER_SERVER=

b. In the Processes Database Name Field, enter a unique name or the default name is OrchestratorProcess. For 
example:

IS_SQLSERVER_DATABASE=OrchestratorProcess

c. If the above database is an existing database, enter: 1, otherwise leave blank. For example:

TDBEXIST=

d. In the Database creation credentials:

— For Windows Authentication of the current user, enter: 0

— For Server Authentication using specific credentials, enter: 1

For example:

IS_SQLSERVER_AUTHENTICATION2=0
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e. If using Server Authentication using specific credentials, enter Username and Password, otherwise leave blank. 
For example:

IS_SQLSERVER_USERNAME=
IS_SQLSERVER_PASSWORD=

2. Under the Processes Database Storage section:

Note: You must use this section when Processes Database is new (TDBEXIST is blank).

a. Verify the default data path (.mdf) and File Size (in MB) (Minimum and Default value is 13) or enter the alternate 
information in the appropriate fields.

For example:

ADMDATAPATH=C:\Program Files\Microsoft SQL 
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA\OrchestratorProcess.mdf

ADMDATASIZE=13

b. Under Transaction Log, verify the default log path (.ldf) and file size (in MB) (Minimum and default value is 7) or 
enter the alternate information in the appropriate fields.

For example:

ADMLOGPATH=C:\Program Files\Microsoft SQL 
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA\OrchestratorProcess_log.ldf

ADMLOGSIZE=7

c. Under Recovery Model, enter the Recovery Model Type:

— To set to Full, enter: FULL

— To set to Simple, enter: SIMPLE

For example:

RECOVERY_MODEL=FULL

Note: The value is Case Sensitive (Default is FULL).

3. Under the Processes Database Access Account section:

Note: You must use this section when Processes Database is new or existing (TDBEXIST is set to 1 or is blank).

a. Specify the credentials for the server to access the database.

— For Windows Authentication, enter: 0

— For SQL Authentication (Mixed mode), enter: 1

For example:

IS_SQLSERVER_AUTHENTICATION5=0

b. Enter the Username and Password. For example:

TIAACCESSACCOUNTNAME=
TIAACCESSACCOUNTPASSWORD=

c. If using Windows Authentication, enter the Domain Name, otherwise leave blank. For example:
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TIADOMAINNAME=

4. Under the Reporting Database section:

a. Enter the Server Name. For example:

IS_SQLSERVER_SERVER1=

b. In the Reporting Database Name Field, enter a unique name or the default name is OrchestratorReporting. For 
example:

IS_SQLSERVER_DATABASE1=OrchestratorReporting

c. If the above database is an existing database, enter: 1, otherwise leave blank. For example:

TDBEXIST1=

d. In the Database creation credentials:

— For Windows Authentication of the current user, enter: 0

— For Server Authentication using specific credentials, enter: 1

For example:

IS_SQLSERVER_AUTHENTICATION3=0

e. If using Server Authentication using specific credentials, enter Username and Password, otherwise leave blank. 
For example:

IS_SQLSERVER_USERNAME1=
IS_SQLSERVER_PASSWORD1=

5. Under the Reporting Database Storage section:

Note: You must use this section when Reporting Database is new (TDBEXIST1 is blank).

a. Verify the default data path (.mdf) and file size (in MB) (Minimum and Default value is 100) or enter the alternate 
information in the appropriate fields. For example:

ADMDATAPATH1=C:\Program Files\Microsoft SQL 
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA\OrchestratorReporting.mdf

ADMDATASIZE1=100

b. Under Transaction Log, verify the default log path (.ldf) and file size (in MB) (Minimum and default value is 20) 
or enter the alternate information in the appropriate fields. For example:

ADMLOGPATH1=C:\Program Files\Microsoft SQL 
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA\OrchestratorReporting_log.ldf

ADMLOGSIZE1=20

c. Under Recovery Model, enter the Recovery Model type:

— To set to Full, enter: FULL

— To set to Simple, enter: SIMPLE

For example:

RECOVERY_MODEL1=FULL

Note: The value is Case Sensitive (Default is FULL).
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6. Under the Reporting Database Access Account section:

Note: You must use this section when Reporting Database is new or existing (TDBEXIST1 is set to 1 or is blank).

a. Specify the credentials for the server to access the database:

— For Windows Authentication, enter: 0

— For SQL Authentication (Mixed mode), enter: 1

For example:

IS_SQLSERVER_AUTHENTICATION6=0

b. Enter the Username and Password. For example:

TIAACCESSACCOUNTNAME1=
TIAACCESSACCOUNTPASSWORD1=

c. For Windows Authentication, enter the Domain Name, otherwise leave blank. For example:

TIADOMAINNAME1=

Updating Oracle NON-RAC Mode Details
This section provides Oracle NON–RAC mode details to be entered in the Cisco Process Orchestrator silent install 
configuration file.

Note: You must use this section when ServerFeature is installed and only if this is a new installation (SERVER_NUMBER 
is set to 1).

Note: You must use this section only when Database Type is Oracle Server (DATABASETYPE is set to 2).

1. Under the Processes Database section:

Note: You must use this section only if this is NOT an Oracle RAC install (RAC_CHECKBOX is blank).

a. Enter the Database Server (<server>:<port number>/<global database name>). For example:

IS_SQLSERVER_SERVER_ORA=

b. Enter the Oracle Service Identifier (SID). For example:

ORACLE_SID=

c. Enter the Account Name and Password to create database. For example:

IS_SQLSERVER_USERNAME_ORA=
IS_SQLSERVER_PASSWORD_ORA=

Note: If the database is preexisting, provide the db schema and password else provide a system account or account 
with dba privileges to create a new database.

2. Under the Processes Database Access Account section:

a. Specify the User/Schema and Password for the server to access the database. (Default is 
OrchestratorProcess). For example:

TIAACCESSACCOUNTNAME_ORA=OrchestratorProcess
TIAACCESSACCOUNTPASSWORD_ORA=
11
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b. If the above user/schema already exists, enter: TRUE, otherwise leave blank. For example:

TDBEXIST_ORA=

Note: The value is Case Sensitive.

3. Under the Oracle Processes Tablespace Datafiles section:

Note: You must use this section only when Processes Database is new (TDBEXIST_ORA is blank).

a. Enter the Database Tablespace file full path (.dbf).

— If Oracle is local to your machine, this should be the location of your oradata\orcl folder. For example:

c:\app\(user)\oradata\orcl\OrchestratorProcessData.dbf

— If your Oracle Server is remote, enter the Name of the file. For example:

OrchestratorProcessData.dbf

For example:

ADMDATAPATH_ORA=

b. Enter the Database Tablespace Size (in MB). (Minimum value is 20 and Default is 500). For example:

ADMDATASIZE_ORA=500

c. Enter the Temporary Tablespace file full path (.dbf).

— If Oracle is local to your machine, this should be the location of your oradata\orcl folder. For example:

c:\app\(user)\oradata\orcl\OrchestratorProcessTemp.dbf

— If your Oracle Server is remote, enter the Name of the file. For example:

OrchestratorProcessTemp.dbf

For example:

ADMLOGPATH_ORA=

d. Enter the Temporary Tablespace Size (in MB). (Minimum value is 10 and Default is 250). For example:

ADMLOGSIZE_ORA=250

4. Under the Reporting Database section:

Note: You must use this section only if this is NOT an Oracle RAC install (RAC_CHECKBOX is blank).

a. Enter the Database Server (<server>:<port number>/<global database name>). For example:

IS_SQLSERVER_SERVER1_ORA=

b. Enter the Oracle Service Identifier (SID). For example:

ORACLE_SID1=

c. Enter the Account Name and Password to create database. For example:

IS_SQLSERVER_USERNAME10=
IS_SQLSERVER_PASSWORD10=
12
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Note: If the database is preexisting, provide the db schema and password else provide a system account or account 
with dba privileges to create a new database

5. Under the Reporting Database Access Account section:

a. Specify the User/Schema and Password for the server to access the database. (Default is 
OrchestratorReporting). For example:

TIAACCESSACCOUNTNAME1_ORA=OrchestratorReporting
TIAACCESSACCOUNTPASSWORD1_ORA=

b. If the above user/schema already exists, enter: TRUE, otherwise leave blank. For example:

TDBEXIST1_ORA=

Note: The value is Case Sensitive.

6. Under the Oracle Reporting Tablespace Datafiles section:

Note: You must use this section only when Reporting Database is new (TDBEXIST1_ORA is blank).

a. Enter the Database Tablespace file full path (.dbf).

— If Oracle is local to your machine, this should be the location of your oradata\orcl folder. For example:

c:\app\(user)\oradata\orcl\OrchestratorReportingData.dbf

— If your Oracle Server is remote, enter the name of the file. For example:

OrchestratorReportingData.dbf

For example:

ADMDATAPATH1_ORA=

b. Enter the Database Tablespace Size (in MB). (Minimum value is 100 and Default is 500). For example:

ADMDATASIZE1_ORA=500

c. Enter the Temporary Tablespace file full path (.dbf).

— If Oracle is local to your machine, this should be the location of your oradata\orcl folder. For example:

c:\app\(user)\oradata\orcl\OrchestratorReportingTemp.dbf

— If your Oracle Server is remote, enter the Name of the file. For example:

OrchestratorReportingTemp.dbf

For example:

ADMLOGPATH1_ORA=

d. Enter the Temporary Tablespace Size (in MB). (Minimum value is 20 and Default is 250). For example:

ADMLOGSIZE1_ORA=250

Updating Oracle RAC Details
This section provides Oracle RAC details to be entered in the Cisco Process Orchestrator silent install configuration file.
13
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Note: You must use this section when ServerFeature is installed and only if this is a new installation (SERVER_NUMBER 
is set to 1).

Note: You must use this section only when Database Type is Oracle Server (DATABASETYPE is set to 2).

Note: You must use this section only if this is an Oracle RAC install (RAC_CHECKBOX is set to 1).

1. Under the Processes Database section, specify the Oracle RAC Server that host the Processes Database.

a. Enter the connection type you want to use:

— For TNS (Requires Oracle Client 11g R2 64-bit), enter: 1

— For Single Client Access Name (SCAN), enter: 2

For example:

RAC_CONN_TYPE=

b. Enter the TNS Alias if RAC_CONN_TYPE is set to 1. For example:

RAC_TNS_ALIAS=

c. Enter the SCAN Host Name, Port (Default is 1521) and Service Name if RAC_CONN_TYPE is set to 2. For 
example:

RAC_SCAN_HOST=
RAC_SCAN_PORT=1521
RAC_SCAN_SERVICENAME=

d. Enter the System Account User/Schema Name and Password. For example:

RAC_USER_SCHEMA=
RAC_PASSWORD=

2. Under the Processes Database Access Account section:

a. Specify the User/Schema and Password for the server to access the database. (Default is 
OrchestratorProcess). For example:

TIAACCESSACCOUNTNAME_ORA_RAC=OrchestratorProcess
TIAACCESSACCOUNTPASSWORD_ORA_RAC=

b. If the above User/Schema already exists, enter: TRUE, otherwise leave blank. For example:

TDBEXIST_ORA_RAC=

Note: The value is Case Sensitive.

3. Under the Oracle Processes Tablespace Datafiles section:

Note: You must use this section only when Processes Database is new (TDBEXIST_ORA_RAC is blank).

a. Enter the Disk Group information for data file. For example:

DISK_GROUP_DATA=DATA

Note: Do not enter plus sign before the value.

b. Enter the Database Tablespace Size (in MB). (Minimum value is 20 and Default is 500). For example:

ADMDATASIZE_ORA_RAC=500

c. Enter the Disk Group information for temp file. For example:
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DISK_GROUP_TEMP=DATA

Note: Do not enter plus sign before the value.

d. Enter the Temporary Tablespace Size (in MB). (Minimum value is 10 and Default is 250). For example:

ADMLOGSIZE_ORA_RAC=250

4. Under the Reporting Database section, specify the Oracle RAC Server that host the Reporting Database.

a. Enter the Connection Type you want to use:

— For TNS (Requires Oracle Client 11g R2 64-bit), enter: 1

— For Single Client Access Name (SCAN), enter: 2

For example:

RAC_CONN_TYPE1=

b. Enter the TNS Alias if RAC_CONN_TYPE1 is set to 1. For example:

RAC_TNS_ALIAS1=

c. Enter the SCAN Host Name, Port (Default is 1521) and Service Name if RAC_CONN_TYPE1 is set to 2. For 
example:

RAC_SCAN_HOST1=
RAC_SCAN_PORT1=1521
RAC_SCAN_SERVICENAME1=

d. Enter the System Account User/Schema Name and Password. For example:

RAC_USER_SCHEMA1=
RAC_PASSWORD1=

5. Under the Reporting Database Access Account section:

a. Specify the User/Schema and Password for the server to access the database. (Default is 
OrchestratorReporting). For example:

TIAACCESSACCOUNTNAME1_ORA_RAC=OrchestratorReporting
TIAACCESSACCOUNTPASSWORD1_ORA_RAC=

b. If the above user/schema already exists, enter: TRUE, otherwise leave blank. For example:

TDBEXIST1_ORA_RAC=

Note: The value is Case Sensitive.

6. Under the Oracle Reporting Tablespace Datafiles section:

Note: You must use this section only when Reporting Database is new (TDBEXIST1_ORA_RAC is blank).

a. Enter the Disk Group information for data file. For example:

DISK_GROUP_DATA1=DATA

Note: Do not enter plus sign before the value.

b. Enter the Database Tablespace Size (in MB). (Minimum value is 100 and Default is 500). For example:

ADMDATASIZE1_ORA_RAC=500
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c. Enter the Disk Group information for temp file. For example:

DISK_GROUP_TEMP1=DATA

Note: Do not enter plus sign before the value.

d. Enter the Temporary Tablespace Size (in MB). (Minimum value is 20 and Default is 250). For example:

ADMLOGSIZE1_ORA_RAC=250

Updating High Availability Details
This section provides HA (High Availability) details to be entered in the Cisco Process Orchestrator silent install 
configuration file.

Note: You must use this section when ServerFeature is installed and only if choosing to add server to HA environment 
(SERVER_NUMBER is set to 2).

1. Under the Server Connection Information section:

a. Provide the connection details. Server Name or IP Address and Port Number (Default Port is 61525). For 
example:

HA_EXISTING_SERVER=
HA_EXISTING_SERVER_PORT=61525

b. Enter the Credentials:

— For current user, enter: 1

— For other user, enter: 2

For example:

HA_EXISTING_SERVER_CREDS=1

c. If other user, enter the Username and Password. For example:

HA_EXISTING_SERVER_USERNAME=
HA_EXISTING_SERVER_PASSWORD=

2. Under the Database Connection Information section. If you are adding this server to an SQL Server HA 
environment, provide the connection details.

Note: You must use this section when ServerFeature is installed and only if choosing to add server to SQL Server HA 
environment (SERVER_NUMBER is set to 2).

a. Enter the SQL Server Connection Server Name or IP Address. For example:

HA_DB_SERVER_EDIT=

b. Enter the SQL Server Name. For example:

HA_DB_NAME_EDIT=

c. For the Windows Authentication (Domain\Username), enter: 1

d. For the SQL Authentication (Mixed mode), enter: 2

For example:
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HA_DB_CONN_INFO_RADIO=1

e. If using Windows Authentication, enter Domain\Username. For example:

HA_DB_USER_EDIT=

f. Enter the authentication Password. For example:

HA_DB_PASSWORD_EDIT=

3. Under the Database Connection Information section. If you are adding this server to an Oracle HA environment, 
provide the connection details.

Note: You must use this section only when Database Type is Oracle Server (DATABASETYPE is set to 2).

Note: You must use this section when ServerFeature is installed and only if choosing to add server to Oracle HA 
environment (SERVER_NUMBER is set to 2).

a. Enter the Oracle Server Connection Server Name or IP Address. For example:

HA_DB_SERVER_EDIT_ORA=

b. Enter the Oracle Server Port. For example:

HA_DB_PORT_EDIT_ORA=

c. Enter the Oracle Service Identifier (SID). For example:

HA_DB_SID_EDIT_ORA=

d. Enter the Oracle DB User/Schema. For example:

HA_DB_USER_EDIT_ORA=

e. Enter the Oracle DB Password. For example:

HA_DB_PASSWORD_EDIT_ORA=

4. Under the Database Connection Information section. If you are adding this server to an Oracle RAC HA 
environment, provide the connection details.

Note: You must use this section when ServerFeature is installed and only if choosing to add server to Oracle RAC 
HA environment (SERVER_NUMBER is set to 2).

a. If using TNS Alias, enter the Name. For example:

HA_RAC_TNS_ALIAS_EDIT=

b. If using SCAN, enter Host Name, Port, and Service Name. For example:

HA_RAC_SCAN_HOST_EDIT=
HA_RAC_SCAN_PORT_EDIT=
HA_RAC_SCAN_SERVICENAME_EDIT=

c. Enter the Oracle RAC DB User/Schema. For example:

HA_RAC_USER_SCHEMA_EDIT=

d. Enter the Oracle RAC DB Password. For example:

HA_RAC_USER_PASSWORD_EDIT=
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Updating Additional Configuration Details
This section provides additional configuration details to be entered in the Cisco Process Orchestrator silent install 
configuration file.

1. Under the Default Role User Assignments section, choose user or group to assign to security roles.

Note: You must use this section when ServerFeature is installed and only if this is a new installation 
(SERVER_NUMBER is set to 1).

a. If you don’t want to configure Active Directory Groups, enter: 1, otherwise leave blank. For example:

SKIP_GROUP_CREATION=1

b. If you wish to assign users or groups, enter the name beside each role (Administrators, Auditors, Definition, 
Operators), otherwise leave blank. For example:

For users, use format: DOMAIN\USERNAME
For local groups, use format: BUILTIN\GROUPNAME
For non-local groups, use format: DOMAIN\GROUPNAME

AD_ADMIN_GROUP_EDIT=

AD_AUDITORS_GROUP_EDIT=

AD_DEF_AUTHORS_GROUP_EDIT=

AD_OPERATORS_GROUP_EDIT=

Note: To assign the Administrators Role you must have Administrator rights.

2. Under the Server Name and Port Number section:

a. Specify the default Server name or IP Address to which the console connects. For example:

DEFAULTSERVERNAME=

b. Specify the default Port Number for the server name (Default is 61525). For example:

DEFAULTPORTNUMBER=61525

Note: You must use this section when ConsoleFeature and/or WebConsoleFeature is installed and only if this is a 
new installation.

Note: You must not use this section if ServerFeature is installed.

3. Under the Windows Runtime User section, enter the default Windows credentials (Username, Password, and 
Domain) to create a CPO Windows Runtime User. For example:

WINDOWS_USER_USER=
WINDOWS_USER_PWD=
WINDOWS_USER_DOMAIN=

Note: You must use this section when ServerFeature is installed and only if this is a new installation 
(SERVER_NUMBER is set to 1).

Note: You must not use this section if TDBEXIST or TDBEXIST_ORA is set to 1.

4. Under the Web Console section:

a. Enter the Web Console Site Name (Default is OrchestratorWebConsole). For example:

WEBCONSOLESITE=OrchestratorWebConsole
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b. Enter the Web Console Port Number (Default is 443). For example:

TCPPORTNUMBER=443

Note: You must use this section when WebConsoleFeature is installed.

Installing Cisco Process Orchestrator Manually
This section provides information to install Cisco Process Orchestrator manually.

Installing Using MSSQL
The Server option installs all database server and client components available in Cisco Process Orchestrator. The user 
will be required to configure the Processes and Reporting database features during the installation process.

With the Client option, you can open multiple instances of the Console on the same client computer. The individual 
Console instances can be connected to the same or different server of any version of the product. 

Use the following steps to install the entire Cisco Process Orchestrator product. This installation includes the client, 
automation server, and web console.

1. Run Setup.exe to start the Cisco Process Orchestrator Autorun Utility.

2. On the Setup tab, click Install Cisco Process Orchestrator to display the Welcome to the Cisco Process 
Orchestrator Setup Wizard panel, then click Next.

3. Review the default installation folder path for Cisco Process Orchestrator, then click Next. 

To change the file path for the installation folder, click Change. This action launches the Change Current Destination 
Folder panel and allows the user to navigate to the appropriate file location.

4. In the Setup Type panel:

a. Select the application options to be installed, then click Next. 

b. Optionally, you can add the Console and Webconsole shortcuts to the Desktop and/or pin them to the taskbar. 

5. In the Cisco Process Orchestrator Server Install Options panel:

a. Under Server Install Options, specify the server install option.

b. In the Environment name field, enter a unique name for the Cisco Process Orchestrator server environment, then 
click Next.

6. In the Database Information panel:

a. Under Database Server, select Microsoft SQL Server Database as the database platform to be created for both 
the Cisco Process Orchestrator Process and Reporting database. 

Field Description

This is a new installation of Cisco 
Process Orchestrator server

Select this option if this is a new installation and you do not 
wish to add a server to an existing High Availability 
configuration. 

Add Cisco Process Orchestrator 
server to an existing High Availability 
configuration

Select this option to add a server to an existing 
environment. 
19



Installing Cisco Process Orchestrator

Installing Cisco Process Orchestrator Manually
b. Under Additional Install Options, check the appropriate configuration check boxes, then click Next. 

7. In the Create Processes Database panel:

a. In the Database server field, enter the appropriate database server path that will be used to store processes and 
other Cisco Process Orchestrator created objects.

b. In the Processes Database name field, enter the name of the database that will be used to store processes 
(default: OrchestratorProcess).

c. Choose Create database using, select the appropriate credentials to be used for creating the database, then 
click Next.

8. In the Processes Database Storage panel:

a. Under Database, verify the default data path and file size or enter the alternate information in the appropriate 
fields:

b. Under Transaction Log, verify the default log path and file size or enter the alternate information in the appropriate 
fields:

Note: To avoid having huge database log files, run daily backups of the Cisco Process Orchestrator database or 
change the recovery model.

Options Description

Restart WMI service during 
installation

Check this check box to restart the Windows Management 
Instrumentation during the installation and ensure that 
certain Cisco Process Orchestrator processes can run 
after the installation. 

If the check box remains unchecked, then the Cisco 
Process Orchestrator processes will not be able to run until 
after the WMI service has been restarted.

Set PowerShell (x64 and x86) 
Execution Policy to “Remote 
Signed”

Note: This option only displays if the PowerShell Execution 
Policy is not set to Remote Signed.

Check the check box to configure the PowerShell 
Execution Policy to Remote Signed.

Field Description

Windows authentication 
credentials of current user

Select this radio button to use the Windows credentials for 
creating the database.

Server authentication using the 
credentials below

Select this radio button and then enter the SQL server 
credentials to use for creating the database.

Field Description

Data path File path to the database data file

Size (MB) Maximum file size for the data file. The database size should not 
be smaller than the model database in the SQL server.

Field Description

Log path File path to the database transaction log file

Size (MB) Maximum file size for the transaction log file.
20



 
Installing Cisco Process Orchestrator

Installing Cisco Process Orchestrator Manually
c. Under Recovery Model, select the Recovery Model type from the list, then click Next.

The default of Full is appropriate for a production level deployment which has routine backups. The note is about this 
mode. For POCs or environments where users will not take daily backups, it is important to set the SQL Server 
recovery mode to Simple. This can dramatically increase Cisco Process Orchestrator database performance and 
reduce disk usage. 

9. In the Processes Database Access Account panel, specify the credentials the server will use to create the database, 
then click Next.

10. In the Create Reporting Database panel, specify the credentials the server will use to create the database, then click 
Next.

11. In the Reporting Database Storage panel:

a. Under Database, verify the data path and file size:

Field Description

Windows authentication Select this radio button and then enter the credentials to use for 
creating a database.

 User—User name for the default Windows user 

 Password—Password credentials for the user name

 Domain—Verify the default Windows domain for the current 
logged in user or enter the new Windows domain.

SQL Server authentication Select this radio and then enter the SQL server credentials to 
use for creating the database.

 User—User name for the SQL Server database

 Password—Password credentials for the user name

Field Description

Database Server The SQL Server that will host the Reporting database

Reporting Database name The name of the Reporting database (default: 
OrchestratorReporting)

Create database using  Windows authentication credentials of the current user

 Server authentication using the credentials below.

— User—User name for the SQL Server database

— Password—Password credentials for the user name

Field Description

Data path File path to the database data file

Size (MB) Maximum file size for the data file. The database size should not 
be smaller than the model database in the SQL server.
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b. Under Transaction Log, verify the log path and file size:

Note: To avoid having huge database log files, run daily backups of the Cisco Process Orchestrator database or 
change the recovery model.

c. Under Recovery Model, select the Recovery Model type from the list, then click Next.

— Choose Full for a production level deployment that has routine backups. 

— For POCs or environments that do not take daily backups, set the SQL Server recovery mode to Simple. This 
can dramatically increase Cisco Process Orchestrator database performance and reduce disk usage. 

12. In the Reporting Database Access Account panel, specify the credentials the server will use to create the database, 
then click Next.

13. In the Default Role User Assignments panel, choose a user or group to assign to the default security roles, then click 
Next.

Note: Click Skip to defer assigning user assignments to the Cisco Process Orchestrator default roles until after the 
installation. 

a. To assign the same user or user group to all default Cisco Process Orchestrator roles, check the Use the same 
assignment for all roles check box. Click Browse to launch the Select User or Group dialog box to query the 
user or user group.

Field Description

Log path File path to the database transaction log file

Size (MB) Maximum file size for the transaction log file.

Field Description

Windows authentication Select this radio button and then enter the credentials to use for 
creating a database.

 User—User name for the default Windows user 

 Password—Password credentials for the user name

 Domain—Verify the default Windows domain for the current 
logged in user or enter the new Windows domain.

SQL Server authentication Select this radio and then enter the SQL server credentials to 
use for creating the database.

 User—User name for the SQL Server database

 Password—Password credentials for the user name
22



 
Installing Cisco Process Orchestrator

Installing Cisco Process Orchestrator Manually
b. To assign a user or group to a default Cisco Process Orchestrator role, click Browse to the right of the appropriate 
role to launch the Select User or Group dialog box to query the appropriate user or user group

14. In the Windows Runtime User panel, enter the default Windows user credentials to create a Cisco Process 
Orchestrator Windows Runtime user, then click Next.

15. In the Cisco Process Orchestrator Web Console panel, specify the website name and port information to be used 
for the Web Console, then click Next.

User Group Description

Administrators Role Full rights to every view on the Console and the ability to 
create and update all process definitions.

Note: Local administrators of the machine where Cisco 
Process Orchestrator is installed will automatically have 
Cisco Process Orchestrator administrator rights, even if 
they do not have specifically granted Cisco Process 
Orchestrator administrator rights.

Auditors Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Cannot start processes in an adhoc manner

 Permission to view all Operation and audit logs

 View, but cannot modify or create product objects 
such as process definitions, target definition or 
administration information.

Definition Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Start processes in adhoc manner

 Cancel running processes

 Permission to view, create, edit, or control product 
definitions such as process definitions and target 
definitions.

 Permission to view but not update administration 
information.

Operators Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Start processes in adhoc manner

 Cancel running processes

 Cannot view or update definition and administration 
information

Field Description

Web site name Enter the product Web Console name. The default is 
OrchestratorWebConsole.

Port Verify the port for the Web Console (Default: 443)
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16. Click Install to install the selected application components.

17. When the Setup Completed panel displays, choose one of the following options:

a. Click Finish to launch the Automation Pack Import Wizard immediately after the install is finished.

b. To prevent the Automation Pack Import Wizard from launching automatically, uncheck the Launch Import 
Automation Pack Wizard now check box, then click Finish.

Installing Using Oracle
Use the following steps to provide the Oracle Database credentials to create a process and reporting database for Cisco 
Process Orchestrator.

Note: The database settings should be case-insensitive. 

1. Run Setup.exe to start the Cisco Process Orchestrator Autorun Utility.

2. On the Setup tab, click Install Cisco Process Orchestrator to display the Welcome to the Cisco Process 
Orchestrator Setup Wizard panel, then click Next.

3. Review the default installation folder path for Cisco Process Orchestrator, then click Next. 

To change the file path for the installation folder, click Change. This action launches the Change Current Destination 
Folder panel and allows the user to navigate to the appropriate file location.

4. In the Setup Type panel:

a. Select the application options to be installed, then click Next. 

b. Optionally, you can add the Console and Webconsole shortcuts to the Desktop and/or pin them to the taskbar. 

5. In the Cisco Process Orchestrator Server Install Options panel:

a. Under Server Install Options, specify the server install option.

b. In the Environment name field, enter a unique name for the Cisco Process Orchestrator server environment, then 
click Next.

6. In the Database Information panel:

a. Under Database Server, select Oracle Database as the database platform to be created for both the Cisco 
Process Orchestrator Process and Reporting database.

Note: (Optional) Check the Oracle Real Application Clusters (RAC) install check box to indicate the Oracle RAC 
should be installed when the Oracle database is installed, then skip to Using Oracle RAC Mode, page 28. 

Field Description

This is a new installation of Cisco 
Process Orchestrator server

Select this option if this is a new installation and you do not 
wish to add a server to an existing High Availability 
configuration. 

Add Cisco Process Orchestrator 
server to an existing High Availability 
configuration

Select this option to add a server to an existing 
environment. 
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b. Under Additional Install Options, check the appropriate configuration check boxes, then click Next. 

7. In the Create Processes Database panel:

a. In the Database server field, enter the appropriate database server path that will be used to store processes and 
other Cisco Process Orchestrator created objects. For example, <server>:<port>/<global database name>.

b. In the Oracle Service Identifier (SID) field, enter the Oracle system ID for the selected database.

c. Choose Create database using, enter the system login ID for the Oracle database server and the password 
credentials for the login ID, then click Next.

8. In the Processes Database Access Account panel, enter the credentials the server will use to access the database, 
then click Next.

9. In the Oracle Tablespace datafiles panel, enter the following information, then click Next.

a. Under the Processes Database Tablespace:

10. Under the Temporary Tablespace:.

Options Description

Restart WMI service during 
installation

Check this check box to restart the Windows Management 
Instrumentation during the installation and ensure that 
certain Cisco Process Orchestrator processes can run 
after the installation. 

If the check box remains unchecked, then the Cisco 
Process Orchestrator processes will not be able to run until 
after the WMI service has been restarted.

Set PowerShell (x64 and x86) 
Execution Policy to “Remote 
Signed”

Note: This option only displays if the PowerShell Execution 
Policy is not set to Remote Signed.

Check the check box to configure the PowerShell 
Execution Policy to Remote Signed.

Options Description

Disk Group Enter the ASM disk group.

Size Enter the maximum file size for the disk group. The 
database size should not be smaller than the model 
database in the Oracle server.

Options Description

Disk Group Enter the ASM disk group.

Size Enter the maximum file size for the disk group. The 
database size should not be smaller than the model 
database in the Oracle server.
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11. In the Create Reporting Database panel, enter the following information, then click Next.

12. In the Reporting Database Access account panel, enter the credentials the server will use to access the database, 
then click Next.

13. In the Oracle Tablespace datafiles panel, enter the following information, then click Next.

a. Under Reporting Database Tablespace:

b. Under Temporary Tablespace:

14. In the Default Role User Assignments panel, choose a user or group to assign to the default security roles, then click 
Next.

Note: Click Skip to defer assigning user assignments to the Cisco Process Orchestrator default roles until after the 
installation. 

a. To assign the same user or user group to all default Cisco Process Orchestrator roles, check the Use the same 
assignment for all roles check box. Click Browse to launch the Select User or Group dialog box to query the 
user or user group.

Options Description

Database Server Enter the appropriate database server path that will be 
used to store processes and other Cisco Process 
Orchestrator created objects. For example, 
<server>:<port>/<global database name>.

Oracle Service Identifier (SID) Enter the Oracle system ID for the selected database.

Create database using Login ID—Enter the system login ID for the Oracle database 
server.

Password—Enter the password credentials for the login ID.

Options Description

User/Schema Enter the name for the user or schema.

Password Enter the password credentials for the user or schema.

Options Description

Data File Enter the name of the file for the Reporting tablespace.

Size (MB) Maximum file size for the disk group. The database size should 
not be smaller than the model database in the Oracle server.

Options Description

Data File Enter the name of the file for the temporary tablespace.

Size (MB) Maximum file size for the disk group. The database size should 
not be smaller than the model database in the Oracle server.
26



 
Installing Cisco Process Orchestrator

Installing Cisco Process Orchestrator Manually
b. To assign a user or group to a default Cisco Process Orchestrator role, click Browse to the right of the appropriate 
role to launch the Select User or Group dialog box to query the appropriate user or user group.

15. In the Windows Runtime User panel, enter the default Windows user credentials to create a Cisco Process 
Orchestrator Windows Runtime user, then click Next.

16. In the Cisco Process Orchestrator Web Console panel, specify the website name and port information to be used 
for the Web Console, then click Next.

User Group Description

Administrators Role Full rights to every view on the Console and the ability to 
create and update all process definitions.

Note: Local administrators of the machine where Cisco 
Process Orchestrator is installed will automatically have 
Cisco Process Orchestrator administrator rights, even if 
they do not have specifically granted Cisco Process 
Orchestrator administrator rights.

Auditors Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Cannot start processes in an adhoc manner

 Permission to view all Operation and audit logs

 View, but cannot modify or create product objects 
such as process definitions, target definition or 
administration information.

Definition Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Start processes in adhoc manner

 Cancel running processes

 Permission to view, create, edit, or control product 
definitions such as process definitions and target 
definitions.

 Permission to view but not update administration 
information.

Operators Role View all Operations information (Activity Views, Process 
Views and Auditing)

 Start processes in adhoc manner

 Cancel running processes

 Cannot view or update definition and administration 
information

Field Description

Web site name Enter the product Web Console name. The default is 
OrchestratorWebConsole.

Port Verify the port for the Web Console (Default: 443)
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17. Click Install to install the selected application components.

18. When the Setup Completed panel displays, choose one of the following options:

a. Click Finish to launch the Automation Pack Import Wizard immediately after the install is finished.

b. To prevent the Automation Pack Import Wizard from launching automatically, uncheck the Launch Import 
Automation Pack Wizard now check box, then click Finish.

Using Oracle RAC Mode
Oracle Real Application Clusters (RAC) provides software for clustering and high availability in Oracle database 
environments. Oracle RAC allows multiple computers to run Oracle RDBMS software simultaneously while accessing a 
single database, thus providing clustering. In an Oracle RAC environment, two or more computers (each with an Oracle 
RDBMS instance) concurrently access a single database. This allows an application or user to connect to either computer 
and have access to a single coordinated set of data.

1. Run Setup.exe to start the Cisco Process Orchestrator Autorun Utility.

2. On the Setup tab, click Install Cisco Process Orchestrator to display the Welcome to the Cisco Process 
Orchestrator Setup Wizard panel, then click Next.

3. Review the default installation folder path for Cisco Process Orchestrator, then click Next. 

To change the file path for the installation folder, click Change. This action launches the Change Current Destination 
Folder panel and allows the user to navigate to the appropriate file location.

4. In the Setup Type panel:

a. Select the application options to be installed, then click Next. 

b. Optionally, you can add the Console and Webconsole shortcuts to the Desktop and/or pin them to the taskbar. 

5. In the Cisco Process Orchestrator Server Install Options panel, select This is a new installation of Cisco Process 
Orchestrator server and enter a unique environment name, then click Next. 

6. In the Database Information panel, select the Oracle Real Applications Clusters (RAC) install option.
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7. In the Processes Database - Oracle RAC panel under Database Information, select the existing Processes database 
server information, then click Next.

8. In the Processes Database Access Account panel under Database credentials, enter the credentials the server will 
use to access the database, then click Next.

9. In the Oracle Tablespace datafiles panel, enter the following information, then click Next.

a. Under Processes Database Tablespace:

A prompt displays requesting you verify there is enough free disk space to support the database files on the remote 
Oracle Server.

Options Description

TNS (Requires Oracle Client 11g R2 
64-bit)

Enter the following:

 TNS Alias—Enter the TNS alias name for detecting an 
RAC only connection.

 Login ID—Enter the system login ID for the Oracle 
database server.

 Password—Enter the password credentials for the 
login ID.

Single Client Access Name (SCAN) Enter the following:

 Host—Enter the Oracle DB SCAN host name.

 Port—Enter the port number for the host.

 Service Name—Enter the Oracle service name.

 System Account—Enter the system login ID for the 
Oracle database server.

 Password—Enter the password credentials for the 
login ID.

Options Description

User/Schema Enter the name for the user or schema.

Password Enter the password credentials for the user or schema.

Confirm Password Reenter the password credentials for the user or schema.

Options Description

Disk Group Enter the ASM disk group.

Size (MB) Enter the maximum file size for the disk group. The 
database size should not be smaller than the model 
database in the Oracle server.
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b. Under Temporary Tablespace:

10. In the Reporting Database - Oracle RAC panel under Database Information, select the existing Reporting database 
server information, then click Next.

11. In the Reporting Database Access account Panel under Database credentials, enter the credentials the server will 
use to access the reporting database, then click Next.

12. In the Oracle Tablespace datafiles panel:

a. Under Reporting Database Tablespace:

Options Description

Disk Group Enter the ASM disk group.

Size (MB) Enter the maximum file size for the disk group. The 
database size should not be smaller than the model 
database in the Oracle server.

Options Description

TNS (Requires Oracle Client 11g R2 
64-bit)

Enter the following:

 TNS Alias—Enter the TNS alias name for detecting an 
RAC only connection 

 Login ID—Enter the system login ID for the Oracle 
reporting database server.

 Password—Enter the password credentials for the 
login ID.

Single Client Access Name (SCAN) Enter the following:

 Host—Enter the Oracle DB SCAN host name.

 Port—Enter the port number for the host.

 Service Name—Enter the Oracle service name

 System Account—Enter the system login ID for the 
Oracle database server.

 Password—Enter the password credentials for the 
login ID.

Options Description

User/Schema Enter the name for the user or schema.

Password Enter the password credentials for the user or schema.

Confirm Password Reenter the password credentials for the user or schema.

Options Description

Disk Group Enter the ASM disk group.

Size (MB) Maximum file size for the disk group. The database size 
should not be smaller than the model database in the 
Oracle server.
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b. Under Temporary Tablespace:

A prompt displays requesting you verify there is enough free disk space to support the database files on the remote 
Oracle Server.

13. In the Default Role User Assignments panel, choose a user or group to create default roles in Cisco Process 
Orchestrator based on users and groups in Active Directory, then click Next.

Note: Click Skip to defer assigning user assignments to the Cisco Process Orchestrator default roles until after the 
installation. 

a. To assign the same user or user group to all default Cisco Process Orchestrator roles, check the Use the same 
assignment for all roles check box. Click Browse to launch the Select User or Group dialog box to query the 
user or user group.

b. To assign a user or group to a default Cisco Process Orchestrator role, click Browse to the right of the appropriate 
role to launch the Select User or Group dialog box to query the appropriate user or user group.

14. In the Windows Runtime User panel, enter the default Windows user credentials to create a Cisco Process 
Orchestrator Windows Runtime user, then click Next.

Note: Optionally, you can click Skip to skip choosing the AD or user for each roles. Only the Administrators Role will 
be assigned to the current installing user.

15. In the Cisco Process Orchestrator Web Console panel, specify the website name and port information to be used 
for the Web Console, then click Next.

16. Click Install to install the selected application components.

17. When the Setup Completed panel displays, choose one of the following options:

Options Description

Disk Group Enter the ASM disk group.

Size (MB) Maximum file size for the disk group. The database size 
should not be smaller than the model database in the 
Oracle server.

Field Description

Administrators Role When assigned to this group, you have access to 
everything in the product. Users can view or modify any 
definition, process, or setting.

Auditors Role When assigned to this group, the user can view any 
definition, such as running processes.

Definition Role When assigned to this group, the user can view or modify 
any definition or workflow.

Operators Role When assigned to this group, users have full access to all 
processes. All processes can be viewed, started, and 
canceled, but cannot be modified.

Field Description

Web site name Enter the product Web Console name. The default is 
OrchestratorWebConsole.

Port Verify the port for the Web Console (Default: 443)
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a. Click Finish to launch the Automation Pack Import Wizard immediately after the install is finished.

b. To prevent the Automation Pack Import Wizard from launching automatically, uncheck the Launch Import 
Automation Pack Wizard now check box, then click Finish.

Manual Installation
You can configure information for Cisco Process Orchestrator using Oracle database 11gR2 running in real application 
clustering. Most of the configuration is applied post-installation. Before the Cisco Process Orchestrator Process 
database can be configured in RAC mode, the Oracle Call Interface (OCI) client must exist on the computer where the 
Cisco Process Orchestrator server is installed.

Use the following steps to configure the Cisco Process Orchestrator process database server in RAC mode. 

1. Install oracle win64_11gR2_client.

2. Create an entry for the Cisco Process Orchestrator oracle service than is running in the tnsnames.ora file as 
mentioned below.

Default location of tnsnames.ora: C:\app\Administrator\product\11.2.0\client_1\network\admin

ORCL =
 (DESCRIPTION =
  (ADDRESS = (PROTOCOL = TCP)(HOST = 172.18.173.24)(PORT = 1521))
  (CONNECT_DATA =
   (SERVER = DEDICATED)
   (SERVICE_NAME = orcl.GIATAC.local)
  )
 )

3. Make sure you are able to successfully do a tnsping to the Oracle SID. For example:

C:\Users\Administrator>tnsping orcl
TNS Ping Utility for 64-bit Windows: Version 11.2.0.1.0 - Production on 05-DEC-2
013 10:51:36
Copyright (c) 1997, 2010, Oracle. All rights reserved.
Used parameter files:
C:\app\Administrator\product\11.2.0\client_1\network\admin\sqlnet.ora
Used TNSNAMES adapter to resolve the alias
Attempting to contact (DESCRIPTION = (ADDRESS_LIST = (ADDRESS = (PROTOCOL = TCP)
(HOST = 172.18.173.24)(PORT = 1521))) (CONNECT_DATA = (SID = ORCL)))
OK (0 msec)

4. Before you run the Cisco Process Orchestrator installer, identify your global database by executing the SQL 
mentioned below.

5. Login as ‘system’ or sys and execute the following:

SELECT * FROM global_name;

For example:

ORCL.GIATAC.LOCAL is the global database
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6. Click Next. You will be prompted to create OrchestratorProcess and OrchestratorReporting tablespaces (The 
password character length is greater than 8 chars).

7. Follow this guide for the next steps.

8. Click Install. 

Installing Cisco Process Orchestrator for a High Availability Environment
1. Run Setup.exe to start the Cisco Process Orchestrator Autorun Utility.

2. On the Setup tab, click Install Cisco Process Orchestrator to display the Welcome to the Cisco Process 
Orchestrator Setup Wizard panel, then click Next.

3. Review the default installation folder path for Cisco Process Orchestrator, then click Next.

Note: To change the file path for the installation folder, click Change. This action launches the Change Current 
Destination Folder panel and allows the user to navigate to the appropriate file location.

4. Select the application options to be installed, then click Next. 

5. Under Server Install Options, select Add a Cisco Process Orchestrator to an existing High Availability 
configuration, then click Next.-

6. In the Server Connection Information panel, provide the following connection details to an existing server in the Cisco 
Process Orchestrator HA environment, then click Next.

Note: By default, if the existing server is using SQL Server, the SQL server connection dialog will be shown. If the 
existing server is using Oracle, the Oracle connection dialog will be shown. The dialog by default will be populated 
with the information that was used to validate the connection to the database, so you will need to modify this 
information with the correct information in order to continue. All fields are required in order to continue and when 
the user presses Next button, the installer will validate the connection to the database and proceed if successful or 
show detailed error if it fails.

Field Description

Server Name or IP Address Enter the product HA server name.

Port Verify the port for the HA server (Default: 61525)

User Name User name for the default user for the HA environment.

 SQL Authorization—select to use your SQL Service 
credentials upon connection to the database.

 AD Authorization—select to use your Active Directory 
credentials upon connection to the database.

Password Password credentials for the user name
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7. In the Database Connection Information panel, enter the following information, then click Next.

8. In the Cisco Process Orchestrator Web Console panel, specify the website name and port information to be used 
for the Web Console, then click Next.

9. Click Install to install the selected application components.

10. On the Setup Completed panel, click Finish. 

Importing Automation Packs
1. On the Setup Completed panel, click Launch Automation Pack Import Wizard now (this is checked by default.)

2. On the Select Automation Packs dialog box, click the automation packs to be imported and click OK.

Note: The Core automation pack check box is checked by default and is always imported first. 

The Welcome to the Automation Pack Import Wizard panel displays

3. Review the display-only information about the automation pack, then click Next.

Note: The settings in this panel can be manually changed when configuring a specific email activity that requires a 
different SMTP server or sender email address. This can also be skipped by unchecking the box next to Enable SMTP 
server for outgoing emails.

Field Description

Database Server Enter the appropriate database server path that will be used to 
store processes and other Cisco Process Orchestrator created 
objects. For example, <server>:<port>\<global database 
name>.

Database Name The name for the database being used to store processes and 
other Cisco Process Orchestrator created objects.

Note: The database name is filled in automatically and is not 
changeable.

Connection Information  Windows Authentication—Select to use your Windows 
credentials upon connection to the database.

 SQL Server Authentication—Select to use your SQL Service 
credentials upon connection to the database.

Database Port For Oracle, enter the database listening port number.

Database SID For Oracle, enter the Oracle system ID for the selected 
database.

Field Description

Web site name Enter the product Web Console name. The default is 
OrchestratorWebConsole.

Port Verify the port for the Web Console (Default: 443)
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4. On the Email Configuration panel, specify the default SMTP server and sender’s email address to be used for email 
activities, then click Next. 

5. On the Automation Summary Configuration panel, specify where the automation summary reports that are generated 
by activities are to be saved and how long the reports are to be retained. The file paths specified indicate the path 
that will be used when viewing the automation summary reports..

6. Verify or enter the appropriate default file path for the automation summary directory. Enter the appropriate directory 
to map the automation summary to a shared directory or IIS Virtual Directory to allow end-users easier access to 
automation summaries using email or the Cisco Process Orchestrator Web Console. 

Field Description

Default SMTP server Name of the SMTP server that is used as the default server for 
sending email messages.

Default SMTP port Port number for the SMTP server. This field is automatically 
populated with port number 25.

Default sender Email address of the sender that is designated as the default 
sender for email activities.

Credentials Required Specify the credentials if they will be required upon sending.

Field Description

Automation summary file share Verify the default file path that the Cisco Process Orchestrator 
server will use when creating automation summary reports.

Click Browse to determine the file share location on the network 
where all the automation summary reports are stored or click the 
Create a share on the current Orchestrator Server link.

Option Description

Automation summary file share
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7. Under Specify the destination for the extracted data, verify the default location where the Cisco Process 
Orchestrator-provided data files should be copied.

8. Under Select data to extract, check the appropriate check boxes, then click Next. 

Share path Enter the UNC path to a share directory. This path will be used when 
viewing the automation summary reports. For example:

(\\servername\sharename\path\filename)

 Create a share on the current Orchestrator Server—Click this 
button to create the directory on the Cisco Process Orchestrator 
server where the automation summary reports should be created.

Note: Verify that the UNC share file path is on a network where the Cisco 
Process Orchestrator service account has write permissions. 

Credentials There is a set of credentials used to write to the share. The account 
specified needs to have a “Batch” logon type in local security policy. It 
is located in Control Panel\All Control Panel Items\Administrative Tools.

 Local Security Policy

 Local Policies

 User Rights Assignment

 Log on as batch job

Virtual directory mapping Select the Enable virtual directory mapping check box to map the 
automation summary share to an IIS virtual directory.

In the Virtual directory path field, enter the http://host:(port)/sharefolder 
that corresponds to a virtual directory in IIS.

If necessary, go to IIS Manager to create your Web Sites and your Virtual 
Directory for the share folder. Use the default settings, change the 
setting if necessary.

Option Description

Business Objects Reports Check this check box to indicate that BIAR report files should be 
copied.

The files are available for importing later into Business Objects.

Microsoft SCOM Management 
Packs

Cisco Process Orchestrator provides management packs for 
integration with the Microsoft System Center Operations 
Manager 2007 framework.

Check this check box to indicate that the SCOM management 
pack files should be copied.

SQL Server Reporting Services 
Reports

Check this check box to indicate that the report files should be 
copied. 

The files are available for importing later into SQL Server 
Reporting Services. 

Note: Reports should be imported after the Automation Pack 
Import Wizard is completed.

Option Description
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The Review Prerequisites panel displays the following information:

9. During the import process:

a. If you click Cancel during the import, the wizard will close and the automation pack will not be imported.

b. If all prerequisites are passed, the wizard automatically continues to the next panel, which displays the status of 
the automation pack objects being imported.

c. If objects are being removed as a result of the updated automation pack, click OK to confirm the removal of the 
objects from the automation pack and Cisco Process Orchestrator.

After the objects have been imported, the importing of the Core automation pack is complete. If other automation packs 
were selected to be imported, the wizard will relaunch for the next automation pack. 

Repairing Cisco Process Orchestrator Installation
In cases where the Cisco Process Orchestrator installation has become corrupted due to lost DLL files or bad files, 
uninstall and then reinstall Cisco Process Orchestrator on the designated computer.

Uninstalling Cisco Process Orchestrator
This section provides the steps used to uninstall Cisco Process Orchestrator from your machine using the Windows Add 
or Remove Programs application. If a language pack is installed, then it will be uninstalled along with Cisco Process 
Orchestrator. 

1. Choose Start > Control Panel > Add or Remove Programs.

2. Select Cisco Process Orchestrator and click Remove.

3. Click Yes on the confirmation dialog box.

Column Description

Name Name of the prerequisite

Status Status shows whether the prerequisite was located on the 
computer 

 Passed—The green check mark verifies that the prerequisite 
was located on the computer.

 Failed—The red X determines that the prerequisite is not 
available on the computer. When this occurs, the import 
progress is stopped and cannot continue until all 
prerequisites have been met.

Complete Percentage of computer checked when verifying prerequisite

Description Displays description of the prerequisite information or 
instructions to further requirements for the prerequisites to be 
installed.
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Configuring the Core Functions Adapter

The Core Functions Adapter provides the basic functionality in Process Orchestrator. Use the Core Functions Adapter 
Properties dialog box to configure default task settings, automation summary report 

Configuring Return on Investment Settings
When you create a process, you have the option to enter the equivalent time it would take to run the process manually. 
This value is calculated against the hourly rate specified on this page to determine the return on investment for the 
process.

1. Choose Administration > Adapters, right-click Core Functions Adapter and choose Properties.

2. On the Core Functions Adapter Properties dialog box, click the ROI tab and specify the hourly rate (in dollars) that it 
would cost to execute a process manually, then click OK. 

Configuring Task Expiration Settings
Use the Task Properties page to specify the default number of days used for the task expiration date. If a task is opened 
on its expiration date, an internal event is raised that can be used to trigger a process. Users will be able to modify the 
date manually on the appropriate task property page.

1. Choose Administration > Adapters, right-click Core Functions Adapter and choose Properties.

2. On the Core Functions Adapter Properties dialog box, click the Task Properties tab. 

3. Under Task expiration days, modify the default task expiration date, then click OK.

Enabling Data Execution Prevention (DEP)
To secure your underlying hardware and operating system in Microsoft Windows 2008 and Windows 2012, use the 
following Data Execution Prevention (DEP) features:

 Hardware-enforced DEP detects code that is running from these locations and raises an exception when execution 
occurs. 

 Software-enforced DEP can help prevent malicious code from taking advantage of exception-handling mechanisms 
in Windows.

To enable DEP in Windows 2008 and Windows 2012:

1. Choose Start > All Programs > Control Panel > System, then click Advanced system settings. 

2. Choose Performance > Settings.
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Hardening the Cisco Process Orchestrator Configuration
3. Click the Data Execution Prevention tab, then check Turn on DEP for all programs and services except those I 
select.

4. Choose the programs and services on which you do not want to run DEP, then click OK.

Hardening the Cisco Process Orchestrator Configuration
Hardening the Microsoft Windows Server operating system reduces the attack surface by disabling functionality that is 
not required while maintaining the minimum functionality that is required. For information about how to harden your 
Windows operating system and to make additional changes to Cisco Process Orchestrator to harden its configuration, 
see the Cisco Process Orchestrator Hardening Guide.

Configuring a High Availability Environment
Because there are a variety of load balancers and you might have your own that you want to use, this section does not 
describe how to set up or configure load balancers. Instead, it explains how to load balance different Cisco Process 
Orchestrator client connections using the generic load balancer, Microsoft Network Load Balancing Manager, as an 
example. 

Microsoft Network Load Balancing Manager is a virtual load balancer that is not as feature-rich as what most customers 
probably use in production environments, but does demonstrate how Process Orchestrator clients work with a generic 
load balancer. 

Setting Up a Load Balancer
To set up Microsoft Network Load Balancing Manager for Process Orchestrator requires at least three to five machines 
and three static IP addresses:

 One machine acts as the cluster host (with a static IP).

 Two machines act as Process Orchestrator servers and Web Consoles. Alternatively, the Web Console could be 
installed on a separate highly-available IIS (with a static IP).

 One machine hosts a High Availability database for Process Orchestrator (for testing purposes this could be the 
same machine as the cluster host).

 One machine performs client testing (for testing purposes this could also be the same as the cluster host).

In the example in the following sections, the cluster/load-balancer is not monitoring specific Process Orchestrator ports 
to verify that the application is healthy, but instead is tested using the Load Balancing Manager software (by stopping 
incoming connections to a specific host) or by shutting down the server or disabling network access on one of the 
Process Orchestrator servers to ensure that load-balancing is occurring. In production, the load balancer should be 
configured to monitor the health of the Process Orchestrator server, northbound web service, or IIS ports to determine 
if the server, northbound web service, or web console are running or down. The default ports are as follows:

 IIS ports: HTTP 2081, HTTPS 443

 SNMP 1: 61

 Console: 61525 

 NBWS: 61526 HTTP, 61527 HTTP0
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Configuring the Console Connection
To configure the Cisco Process Orchestrator console to connect through the load balancer:

1. Choose Start > Cisco Process Orchestrator Console, then in the Select Server dialog, enter the host name of the 
load balancer cluster. 

2. To verify that the connection is being made through the load balancer, check the Cisco Process Orchestrator 
Console; the load balancer URL should appear in the title bar.

3. To ensure that load balancing is running successfully, perform one of the following actions on the load balancer:

a. Select a specific host and Stop or Drainstop connections to that host. 

b. Disable the network interface or bring down the server that the Process Orchestrator is running on. 

In a production environment, you should be monitoring the server port, and can test just by bringing it down.

Configuring the NBWS Connection
Before You Begin
Configure the Cisco Process Orchestrator console to connect through the load balancer (see Configuring the Console 
Connection, page 41).

1. Choose File > Environment Properties > Web Service.

2. Enable the Web Services. By default, the port for HTTPS is 61526 and for HTTP is 61527. 

3. Set up SSL on your Process Orchestrator servers. 

You should not need to do any additional certificate setup or configuration on the load balancer itself.

4. Configure any Northbound connections to connect through the load balancer. For example, to connect to the Target 
Northbound Web Service using the default HTTPS port, connect to:

https://<load-balancer-name>:61526/WS/Target?wsdl

5. To ensure that load balancing is running successfully, perform one of the following actions on the load balancer:

a. Select a specific host and Stop or Drainstop connections to that host. 

b. Disable the network interface or bring down the server that the Process Orchestrator is running on. 

In a production environment, you should be monitoring specific NBWS ports, and can test just by bringing them down.

Configuring the Web Console Connection
Before You Begin
Configure the Cisco Process Orchestrator console to connect through the load balancer (see Configuring the Console 
Connection, page 41).

1. Choose File > Environment Properties.

2. Click the General tab and enter the required information, then click Save.
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a. In the Web Console location field, enter one of the following:

— The load balancer URL. This is what gets set as the task URL for tasks and can be sent in emails as a URL location 
to the Web Console. This is also what is used to open and complete the task using the Web Console.

— The IP address of the cluster in the Web Console location.

3. Copy the Web Console URL, which is now using load balancer URL in the environment properties dialog, into your 
browser and confirm that the Web Console is displayed properly.

4. On each server, confirm that IIS authentication for the orchestratorwebconsole web site and 
OrchestratorWebConsole application under it is set to only use basic authentication and ASP.NET Impersonation. 

5. Using an ASCII text editor, edit the file C:\Program Files\Cisco\Cisco Process 
Orchestrator\WebConsole\Web.config:

a. In the <system.web> section, verify <authentication mode=”Windows” /> and
<identity impersonate=”true” />.

b. In the <appsettings> section, set <add key=”WebServiceUris” value=”the load balancer’s URL” />.

6. To ensure that load balancing is running successfully, perform one of the following actions on the load balancer:

a. Select a specific host and Stop or Drainstop connections to that host. 

b. Disable the network interface or bring down the server that the Process Orchestrator is running on. 

In a production environment, you should be monitoring the IIS port and can test just by bringing it down.
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Upgrading from 3.2.1 to 3.2.2.

The 3.2.2 upgrade calls the needed SQL scripts to perform the upgrade operation based on the existing version found.

Important: Follow manual upgrade steps if the database schema has been modified for this setup.

Upgrading the Oracle Database
Before You Begin
 Back up the database.

 You must have the appropriate database rights to run the scripts. 

1. Install the OCI client that is compatible with the Oracle database server, if it not already installed.

2. Choose Start > Run.

3. On the Run dialog box, in the Open field, type cmd and press Enter.

4. Run the following scripts in the order as they are listed.

a. Log in as the user/schema that the process db is named (OrchestratorProcess is the default user/schema for 
previous versions of Cisco Process Orchestrator), then enter:

Execute OrchestratorProcessUpgrade.sql 

Execute OrchestratorProcessViews.sql

b. Log in as the user/schema that the report db

c. is named (OrchestratorReporting is the default user/schema for previous versions of Cisco Process 
Orchestrator), then enter:

— Execute OrchestratorReportingUpgrade.sql

5. Install Cisco Process Orchestrator 3.2.2. To upgrade the previous Cisco Process Orchestrator server, see Installing 
Using Oracle, page 24).

6. Verify that the system works.

Upgrading the MSSQL Database
Important: If the Process Orchestrator server is configured to use Windows authentication to access the process 
database, manually upgrade the Process database and Reporting database before upgrading to Cisco Process 
Orchestrator 3.2.2.

Note: If needed, you must rename the database names in the scripts to the current database names on your environment 
before running the scripts.
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Upgrading from 3.2.1 to 3.2.2.
Before You Begin
 Back up the database.

 You must have the appropriate database rights to run the scripts. 

1. Open Microsoft SQL Server Management Studio.

2. Run the following scripts:

a. \Release\DatabaseScripts\MSSQL\OrchestratorProcessUpgrade.SQL 

b. \Release\DatabaseScripts\MSSQL\OrchestratorReportingUpgrade.SQL 

3. Edit \Release\DatabaseScripts\MSSQL\OrchestratorProcessViews.SQL:

a. Change the database name in the script if it is not the default name OrchestratorProcess.

b. Run the script.

4. Install Cisco Process Orchestrator 3.2.2. To upgrade the previous Cisco Process Orchestrator server, see Installing 
Using MSSQL, page 19.

5. Verify that the system works.

Using the MSSQL backend and installation to perform the script execution
To upgrade the previous Cisco Process Orchestrator server, see Installing Using MSSQL, page 19. 
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This section provides information on creating the databases manually.

Creating the Oracle Database
1. Log in as System user.

2. Create process database user by executing OrchestratorProcessCreateUser.sql.

Note: Modify the script as needed. For example, you may need to change the datafile, initial size and password.

3. Create reporting database user by executing OrchestratorReportingCreateUser.sql.

Note: Modify the script as needed. For example, you may need to change the datafile, initial size and password.

4. Run the following scripts in the order as they are listed.

a. Log in as process database user, then enter:

Execute OrchestratorProcess.sql 

Execute OrchestratorProcessForEnterpriseEdition.sql

Note: You must use OrchestratorProcessForEnterpriseEdition.sql only for enterprise edition.

Execute OrchestratorProcessViews.sql

b. Log in as reporting database user, then enter:

Execute OrchestratorReporting.sql

Creating the MSSQL Database
1. Log in as System user.

2. Create Process database user, see Process Database Logon Script, page 4.

3. Create Report database user, see Reporting Database Authentication Script, page 4.

4. Run the following scripts in the order as they are listed.

a. Log in as process database user, then enter:

Execute OrchestratorProcess.sql 

Execute OrchestratorProcessForEnterpriseEdition.sql

Note: You must use OrchestratorProcessForEnterpriseEdition.sql only for enterprise edition.

Execute OrchestratorProcessViews.sql

b. Log in as reporting database user, then enter:
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Creating the MSSQL Database
Execute OrchestratorReporting.sql
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